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Disclaimer

Dimensional Insight, Inc. disclaims the implied warranties of merchantability and fitness for a particular purpose and
makes no express warranties except as may be stated in its written agreement with and for its customer.

In no event is Dimensional Insight liable to anyone for any indirect, special, or consequential damages. The
information and specifications in this manual are subject to change without notice.

Copyright © Dimensional Insight, 1991-2020.

Trademarks

Microsoft®, Windows®, and Excel® are registered trademarks of Microsoft Corporation in the United States and
other countries.

AIX®, AS/400®, and DB2® are registered trademarks and iSeries™ is a trademark of International Business
Machines Corporation.

Adobe®, Acrobat®, and Distiller® are registered trademarks of Adobe Systems Incorporated.

Oracle® and Java® are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their
respective owners.

Google Maps™ is a trademark of Google Inc. Other product and company names mentioned in this manual are the
service mark, trademark, or registered trademark of their respective owners.

Limited Warranty and Liability

Dimensional Insight, Inc. (DII) is the owner of the Software to which this documentation applies. The Software is
subject to copyrights, patents and other intellectual property rights of DII, is furnished only under a license to use it,
and no ownership rights are conveyed in the Software under any circumstances. License rights are set out in written
license agreements entered into by all licensees either prior to delivery of the Software or prior to first use of the
Software. No use of the Software is permitted unless the user has first agreed to the terms of the license. DO NOT USE
THE SOFTWARE IF YOU HAVE NOT REVIEWED AND AGREED TO THE TERMS OF THE LICENSE.

THE SOFTWARE IS FURNISHED “AS IS” AND WITHOUT WARRANTY OF ANY KIND OR NATURE TO THE
EXTENT PERMITTED BY APPLICABLE LAW. DII EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS,
IMPLIED OR STATUTORY, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS
FOR PARTICULAR PURPOSE, SATISFACTORY QUALITY AND NONINFRINGEMENT, AND THEIR
EQUIVALENTS UNDER ANY LAW OF ANY JURISDICTION. IF APPLICABLE LAW IMPLIES ANY
WARRANTIES OR CONDITIONS WITH RESPECT TO THE SOFTWARE, ALL SUCH WARRANTIES OR
CONDITIONS ARE LIMITED TO A PERIOD OF THIRTY (30) DAYS FROM THE DATE OF DELIVERY OF
THE SOFTWARE TO THE LICENSEE.

DII DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, DII
DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF
THE USE OF THE SOFTWARE IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR
OTHERWISE. SHOULD THE SOFTWARE PROVE DEFECTIVE, LICENSEE (AND NOT DII, ITS
DISTRIBUTORS, DEALERS OR EMPLOYEES) WILL ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR, OR CORRECTION.
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SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF EXPRESS OR IMPLIED
WARRANTIES OR CONDITIONS UNDER CERTAIN CIRCUMSTANCES, SO THE ABOVE EXCLUSIONS
MAY NOT APPLY TO YOU. IF SUCH EXCLUSIONS DO NOT APPLY TO YOU, AND ONLY IN SUCH EVENT,
YOUR SOLE REMEDY WILL BE, AT DII’S OPTION, REPAIR OR REPLACEMENT OF THE SOFTWARE OR
A REFUND OF THE PRICE PAID BY YOU FOR THE SOFTWARE. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS WHICH VARY FROM STATE TO STATE
AND JURISDICTION TO JURISDICTION.

While efforts have been made to ensure THAT the program and its documentation are free from defects, under no
circumstances and under no legal theory, whether tort, contract, or otherwise, shall DII, or its distributors, dealers or
employees, be liable to you or any other person for any loss or damage sustained in connection with ANY ATTEMPT
TO use the Software, including without limitation, any economic, consequential or other indirect loss or damage, even
if DII has been previously advised of the possibility of such loss or damage. Some states and jurisdictions do not allow
the exclusion or limitation of INCIDENTAL or consequential damages under certain circumstances, so this limitation
and exclusion may not apply to you.

U.S. Export Administration Act: Restrictions on Exporting Software

The Software may include certain cryptographic software that may be subject to export controls under the U.S. Export
Administration Act. The Software may not be exported to any country or to any foreign entity or “foreign person” to
the extent prohibited under applicable U.S. government regulations. By downloading or using the Software, you are
acknowledging and agreeing to the foregoing limitations on your right to export or re-export the Software, and are also
representing and warranting that you are neither on any of the U.S. government’s lists of export precluded parties nor
otherwise ineligible to receive software containing cryptography that is subject to export controls under the U.S.
Export Administration Act.

If a version of DiveLine that uses encryption is running, administrators must be aware that allowing users outside the
United States to access data via certain DI-Clients qualifies as exporting encryption software (either the client
executable or the Java applet sent to the browser). Export or re-export of encrypted software must be in accordance
with the Export Administration Regulations. Diversion of encryption software contrary to U.S. law is prohibited.

Third Party Licensing

OpenSSL Toolkit

The licensing below applies to the third party encryption library routines ONLY.

This product may include software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/) [Copyright © 1998-2011 The OpenSSL Project. All rights reserved.]

This product may include cryptographic software written by Eric Young (eay@cryptsoft.com) [Copyright ©
1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.]

Below are the two licenses which cover the use of these routines.
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts. Actually both licenses are BSD-style
Open Source licenses. In case of any license issues related to OpenSSL
please contact openssl-core@openssl.org.

OpenSSL License
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/*

L I I S R T I R R R I S S R T T T TN N N N N I N R A

*

R R

Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without
prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ~"AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjhecryptsoft.com).
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Original SSLeay License

L I N S T T R R R N S I I I I R S T T T T SN N RN N N N S S R

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com) .
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are adhered to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjhe@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in

the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.

This can be in the form of a textual message at program startup or

in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library
being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjhecryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ~"AS IS'' AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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* The licence and distribution terms for any publicly available version or
* derivative of this code cannot be changed. i.e. this code cannot simply be
* copied and put under another distribution licence
* [including the GNU Public Licence.]
Apache Libraries

DivePort, NetDiver, and DIAL use libraries covered under the license below.

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and
limitations under the License.

Apache Commons Codec
Copyright 2002-2012 The Apache Software Foundation

Apache HttpComponents Client
Copyright 1999-2012 The Apache Software Foundation

Apache Commons Logging
Copyright 2003-2007 The Apache Software Foundation

Apache POI
Copyright 2009 The Apache Software Foundation

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/) .

This product contains the DOM4J library (http://www.dom4j.org) .
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

This product contains parts that were originally based on software from BEA.
Copyright (c) 2000-2003, BEA Systems, <http://www.bea.com/>.

This product contains W3C XML Schema documents. Copyright 2001-2003 (c)
World Wide Web Consortium (Massachusetts Institute of Technology, European
Research Consortium for Informatics and Mathematics, Keio University)

This product contains the Piccolo XML Parser for Java
(http://piccolo.sourceforge.net/). Copyright 2002 Yuval Oren.

This product contains the chunks parse cmds.tbl file from the vsdump program.
Copyright (C) 2006-2007 Valek Filippov (frobedf.ru)
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Google Automated Error Reporting

This product includes portions of automated error reporting software which require the display of the following
disclaimer. This disclaimer applies only to those portions of code, not to the product as a whole.

Copyright (c) 2010, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2020 Dimensional Insight, Inc., 60 Mall Road, Burlington, MA 01803
(http://www.dimins.com)
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Chapter 1 rersor
Introduction

DI-Broadcast is a DiveLine client that is configured to automatically send e-mail based on a
defined set of business rules and parameters. As data is updated, e-mail is sent, alerting recipients
to take action or make decisions based on the data. The DI-Broadcast process runs in an automated
and scheduled environment so users do not have to manually find information. This automation
ensures that important information is not lost or overlooked.

Using the DI-Broadcast Manual

This manual is separated into three chapters:

* Chapter 1, Introduction - contains an overview of the manual, a description of
DI-Broadcast’s usage, a list of helpful terms, and installation and startup steps for the
software.

* Chapter 2, The DI-Broadcast Environment explains the DI-Broadcast interface and
menus.

* Chapter 3, Creating and Editing Jobs explains the DI-Broadcast job creation
process.

Additional Documentation

This manual is intended for users who are already familiar with the Diver and DiveLine software.
Companion manuals are as follows:

» Diver - contains information about creating the Markers and Reports to be sent using
DI-Broadcast.
» Diveline- contains information about DiveLine installation and configuration.

» DI-Scheduler - contains information about configuring scheduled jobs and events that
can then be used to trigger jobs configured in DI-Broadcast.
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Contacting Support

» Diver Solution Licensing - contains information about DI Software licensing
requirements and procedures

Contacting Support

Customer support is available from 7:00 AM to 5:00 PM (Central Time).

Table 1-1: Technical Support Contact Information

Customer Type Phone Fax Email
Domestic Users 920-436-8299 920-433-2378 support@dimins.com
International +1-920-436-8299 | +1-920-433-2378 | international@dimins.com
Users

Diver Solution Licensing

Dimensional Insight software is licensed to ensure that only those authorized to use it can do so.
DI licensing is by Named Users and applies to production software: DiveLine and its clients, Data
Integrator, Builder, DiveMaster, and DI-Production, as well as the DI-Diver client (in special
circumstances). Back-end components require a license key for each system they are to be
installed on. This license allows for the software to be used in perpetuity. In the server/client
environment, client license requirements are dictated by DiveLine. When your company purchases
from Dimensional Insight, the required software licensing will be articulated. For more
information, please refer to the separate Diver Solution Licensing manual.

1-2 Introduction
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DI-Broadcast Requirements

DI-Broadcast Requirements

DI-Broadcast is supported on Microsoft Windows XP SP3, 2003 Server, 2008 Server, 2012 Server,
2016 Server; MS Windows 7, 8, and 10. The following requirements must be met for DI-Broadcast
to run successfully:

» DiveLine must be running on the server.

* DIAL (Dimensional Insight Access Language) must be running on the server and must
be executed by an Advanced level DiveLine Administrator.

* A functional e-mail server is needed to send e-mail via the DI-Broadcast client.

DI-Broadcast configuration information can be found below under Configuring DiveLine for use
with DI-Broadcast.

Troubleshooting Java Memory Problems

DI-Broadcast runs Javaon dial . jar. If you are experiencing memory issues, you can adjust the
amount of memory allocated to Java by doing the following:

1. Open the Windows Control Panel and select Java.

2. On the Java tab of the Java Control Panel, click on the View button to “manage Java
Runtime versions and settings”.

3. For the JRE in use, enter -Xmx2048 in the Runtime parameters box. Depending on your
system, you may want to try Xmx1024 instead.

4. Click OK and Apply.

Useful Definitions

DIAL (Dimensional Insight Access Language) - DIAL is a high-level programming language
designed to process, analyze, and distribute information contained in Dimensional Insight Models.
DIAL programs are executed through the DIAL interpreter, a command-line program. When
executed, DIAL programs can process Markers, producing the results as e-mail or saved files.

Marker (.mrk) - A file containing a record of all actions taken in a dive. Markers can be reopened
to the final dive window that was saved. A Marker does not store actual data but presents the
current data when reopened. Markers are created in Diver.

Job - As used in this manual, a job is a DI-Broadcast process predefined by the user that opens and
e-mails a file to a specified recipient or group of recipients.
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Configuring DiveLine for use with DI-Broadcast

Configuring DiveLine for use with DI-Broadcast

There are two options for configuring DI-Broadcast within DiveLine: configuration in DI-Config,
and manual configuration. Configuration within DI-Config is recommended, but limited.

Using DI-Config

The DI-Config program installed with DiveLine allows a DiveLine administrator to configure the
DiveLine server for DI-Broadcast. Information on using DI-Config can be found in the DivelLine
manual.

1. Log in to DI-Config, selecting the appropriate Server and Port.
2. On the General Tab of DI-Config, click the Scheduler... button.

Di-Diveline Config
Ganoral | Aliases | Usess | Groups | ACL | Licensing | Audt |
Sirsit Infarmaton
| 51 Sarver Memd ghusras sandbos: diming oom (pon 2130) [ Change Senor,_
Top-Level Deciony: fdifsolubon/di-datasoct
Encrypton AESIEE-SHA,
_ Ao |
Securty Divelne Safings
Securty Lirvel Meoirmizm connacions (use 0 for unlimed) i
i~ Leveld Al objects controlfed by access control list Hno
© Lovell access coniol list is listed jor an object, the [ Limai Lisers fo smgle Log i (it non Admin)
i object is inaccessible
i Lovel2
Cache Sashus i Mresr " Diveplan 8 Alverys
Auhintication Type
 OWHN Cirvelie wses an LOWP sarver ios nuthanbcabion I Use simple ancryption on soved ACL Fies
~ =ySTE
[T Dusconnect idle users minute bmaout
™ Web Server
& LOAR wa'l |
[~ NonrAdminisymior Lisers con be setio adminisier other Users
Yersion Cowol | Schedular
[T Accounts are locked-out afer 0 tailed login afempts
r [ Errest Fieporing I W] |
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The Scheduler and Broadcast Settings dialog is presented:

— Scheduler-
Path to Builder executable (e.g. Chdibuilder exa)

Fath to Integrator executable (e.g. Cldiinteg.exe)

l

- Broadcast

a0 Jawva executable (e.g. C\Program Files\Javaljre1 5.0_07\birkjavaw axa)

[clpmgmm files (A6 jenaiyre Pbinyava exe Browse.

Fath to DLAL jar file
lcfl.dl_snluljclnEﬂ\mamluﬂlasﬁdidjur

Broadcast from address (e.g. broadcast@dimins.com)

[rgenlﬂe@ﬂimins.mm

Broadcast mail server (2.g. mail.diming.com)

[mnil.dimins_mm

SMTF user name
[un‘rnin

SMTP password

H

DI-Scheduler settings are not required to use DI-Broadcast.
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3. Enter all DI-Broadcast variables, each of which is described below:

Path to Java executable - specifies the system path to the Java executable.
Path to DIAL jar file - specifies the system path to the dial.jar file.

Broadcast from address - specifies the e-mail address that DI-Broadcast should
use for sending.

Broadcast mail server - specifies the mail server that DI-Broadcast should send
mail from.

SMTP (Simple Mail Transfer Protocol) user name - specifies a valid login user
name for the DI-Broadcast mail server.

SMTP (Simple Mail Transfer Protocol) password - specifies a valid login
password for the DI-Broadcast mail server.

4. Click OK to accept the changes and exit the dialog.
5. Click Save and Exit to commit the changes and exit DI-Config.

6. Restart the DiveLine service according to your installation environment. Please refer to
the DivelLine manual for more information on restarting DiveLine on different
platforms.

TIP: See Note on the following page.

Performing Manual Configuration Steps

The directions below outline the process for manually configuring the DiveLine server for use with
DI-Broadcast. A list of all instances of the DiveLine service can be obtained by typing on the
command line:

di-service.exe -list

To manually configure DI-Broadcast:

1. Stop the DiveLine service according to your installation environment (for information
specific to your platform, please refer to the Diveline manual).

2. Open the /dl-dataroot/config/atlcfg.cfg file in a text editor.
3. Copy the following lines into the atlcfg.cfg file:

java exe path="C:\\<java path>\\java.exe”,
dial jar path="C:\\<solution path>\\dial.jar”,

broadcast from address=“Broadcast@<domain>",
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broadcast mail server="<mail servername>.<domain>",
broadcast mail tls=“<enabled, disabled, or required>",
smtp_auth username= “username”,

smtp_auth password= “password”,
Modify these lines to work with your system, for example:
dial jar path="C:\\DI Solution\executables\\dial.jar”,
Save the modified atlcfg.cfg file.

The beginning portion of the modified atlcfg.cfg file should look similar to the sample
below:

version “17;

/I Computer generated object language file

object 'ACFG' “main”
auth_scheme="own”,
security level=2,
java_exe path="c:\\program files\\java\\jdk1.6.0 14\\bin\\java.exe”,
dial jar path="c:\\DI_Solution\\executables\\dial.jar”,
broadcast from address=“broadcast@dimins.com”,
broadcast mail server="mail.domain.com”,
broadcast mail tls="enabled”,
smtp_auth username= “admin”,
smtp_auth password= “admin”,

maxusers=100,

6. Restart the DiveLine service.

£

Starting with version 7.0, certain paths are maintained in Workbench Server
Settings. When executed, DI-Broadcast resolves paths for Java and DIAL
using the dl-dataroot/config/path overrides.cfgifit
exists. Version 7.0 also introduced the control option for TLS.

Introduction
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Starting DI-Broadcast

You must be an Advanced level user to log in to DI-Broadcast. To start using DI-Broadcast,

1. Locate and double-click the broadcast.exe file.

2. From the Open File - Security Warning dialog, verify DI is the publisher, then click
Run.

3. You will be prompted to enter the DiveLine Server to connect to, as shown below. Enter
a Server Name and port number (if the default port 2130 is not being used), and click
Select.

M Select Diveline Server...

Server Mame  |EN{EERER00

Select | Exit |

4. Enter your username and password.

I Diveline Login...

Server sunflower 5400

|l zername: |admin

Passwaord: [

OF. | Cancel |
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Starting DI-Broadcast

£ Di-Broadcast

Connection Jobs Events Wiew Help

Connected to sunflower: G400 az admin
Narme:

S ales Marker

CBX)

o
M oritkiy

Mew.. | Edt. | Delete.. |

Server Time: 4:09:21 PM

When you log in, you will be presented with the DI-Broadcast startup screen shown here
and described in the next chapter.
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Troubleshooting DI-Broadcast

If problems arise with a DI-Broadcast job, there are two parameters that can help find the problem.
The following lines can be added to the atlcfg.cfg file during manual installation:

scheduler save temp files="true",
scheduler debug dial="true",
scheduler extreme debugging="true",

When DI-Broadcast is executed, it generates a temporary DIAL script used to run the job. The
scheduler _save temp files line tells DiveLine to save this temporary script. In the event of a job
failure, this script can be located in the dl-dataroot/temp directory and manually executed using
DIAL to view the debug information.

Depending on the contents of the DIAL script, more than one temporary file maybe generated. For
example:

schC663 . tmp - Marker dive window
schC664 . tmp - DIAL script

schC665 . tmp - email message

Working with Your Mail Server

Be aware that unattended services (such as DI-Broadcast) sending e-mail are not the same as a user
sending e-mail from his or her mail client. The mail server may place restrictions on relaying
e-mail based on how the sender connects and authenticates.

If a mail server rejects e-mail submissions from DI-Broadcast, consult the mail logs on that server.
The server name is recorded in altcfg. cfg. Typically the mail server will reject the e-mail
because it concludes it is being used to relay spam. This decision is made based on:

» the domains of the to/from addresses

 the source IP address of the submitter (the Diveline server)

» whether or not the email was submitted after authentication or anonymously

Usually the mail server configuration needs to be modified to allow a relay from the DiveLine
server, or SMTP authorization credentials need to be entered into DI-Config/atlcfg.cfg so that
DiveLine authenticates first when sending e-mail.

You will need to involve your IT personnel responsible for the mail server for assistance. Below is
a sample of the type of information you may need to relay to your IT person (fill in the items in
angled brackets <> with information specific to your system).
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“We have software running on server <SERVERNAME> that wishes to send e-mail to
recipients outside of our network. We have observed that this service can send e-mail to
internal addresses, but not external ones. We would like you to either make a relaying
exception for our use or assign us a username and password that the service should use when
trying to send e-mail.
We are currently using the following settings:

Start DI-Config and click the Scheduler button

From address: <Broadcast from address>

Mail server: <Broadcast mail server>
SMTP username: <SMTP user name. Might be blank presently.>

Are these settings correct?

If necessary, please consult the mail server’s logs to determine the reason that our automated
e-mails to remote recipients are being rejected. I can generate a test message whenever you
would prefer.”

Engaging help from your IT department should insure a successful configuration of DI-Broadcast
within your network’s infrastructure. If the problem persists, contact Technical Support.

Introduction 1-11



DI-BROADCAST



Dimensional
I NS 1 6 HT

Chapter 2

The DI-Broadcast
Environment

This chapter describes the interface you will use to create and maintain DI-Broadcast jobs. It
includes a description of the main DI-Broadcast dialog and details each DI-Broadcast menu item.

The DI-Broadcast Startup Dialog

At startup, the main DI-Broadcast dialog shown below is displayed. An explanation of each area
of the main dialog and each menu option follows.

£ DI-Broadcast E!@I!EI

Connection  Jobs Events Wiew Help

Connected to sunflower: G400 az admin

Server Time: 4:09:21 PM

Sales Marker

Last Fun
o 202011 160307

Mexd Fun
200202 12:00:00

Hew... Edit... Delete.,

The DI-Broadcast Environment
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The DI-Broadcast Startup Dialog

Connected to/as

This area displays the name of the DiveLine server that you are connected to, as well as the
username that you are connected as.

Server Time

The Server Time area displays the current time on the DiveLine server that you are connected to.
The time is given in the format hh:mm:ss AM/PM.

Name

The Name column shows the names of DI-Broadcast jobs that are currently configured. This list
will include all currently configured jobs in both DI-Broadcast and DI-Scheduler (All jobs), or
only the jobs configured in DI-Scheduler (Scheduler jobs), depending on whether “All jobs” or
“Scheduler jobs” has been selected from the View menu. The default selection is “Scheduler jobs”.

Type

This column specifies the type of schedule being followed by the named job. Schedule types
include Hourly, Daily, Weekly, Monthly, Yearly, Once, Event, Never, and Other, each of which are
explained in detail in Chapter 3, Creating and Editing Jobs.

Owner

The Owner column lists the named user the job belongs to. The Owner column is only displayed
when the “All Jobs” option is selected from the View menu.

Last Run

This column lists the date and time the job was last executed successfully. The date is given in the
format yyyy/mm/dd and the time in the format hh:mm:ss (24-hour clock).

Next Run

This column lists the date and time the named job is scheduled to run again. The date is given in
the format yyyy/mm/dd and the time in the format hh:mm:ss (24-hour clock).
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The DI-Broadcast Startup Dialog

New

The New button opens the New Job dialog, allowing you to create a new DI-Broadcast job.

Edit/Examine

The Edit button opens the Edit Job dialog, allowing you to change configuration of the currently
highlighted job.

When a job is locked, “Edit” becomes “Examine”. When Examine is displayed, the job can be
opened and viewed, but changes cannot be made. A job is locked when the job is running or when
another user has the job open in Edit mode in a different DI-Broadcast connection.

Delete

The Delete button permanently removes the currently highlighted job from DI-Broadcast.
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Menus

DI-Broadcast has 5 menus to assist you in server connection, job creation, and job maintenance:

* Connection Menu
* Jobs Menu

* Events Menu

* View Menu

* Help Menu

Each menu item is described in the following sections.

Connection Menu

The Connection menu allows you to specify the DiveLine server you are connecting to or exit the
software.

whbs Events Vi

Select Server. ..

Exit: Al+F4

Select Server...

The Select Server menu item allows you to choose another DiveLine server to connect to. You
will be asked to commit any job changes made before the connection is switched.

Exit

This menu option closes DI-Broadcast. You will be asked to commit any job changes made before
exiting.
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Menus

Jobs Menu

The Jobs menu provides options needed to create, edit, run, review, and remove jobs in
DI-Broadcast.

WelseN Events Miew Help

Mew job. ..
Edit job...
Delete job...
Copy job...

Execute job...
Cancel job...

Review job history. .,
Save Job Report. ..

New job...

The New job option opens a dialog allowing you to configure a new DI-Broadcast job. See
Chapter 3, Creating and Editing Jobs for detailed information on new job configuration.

Edit/Examine job...

The Edit job option allows you to open a previously configured job and change or update its
current settings.

When a job is locked, “Edit job...” becomes “Examine job...”. When Examine job is displayed,
the job can be opened and viewed, but changes cannot be made. A job is locked when another user
has that job open in Edit mode in a different DI-Broadcast connection or when the job is running.

Delete job...

Delete job allows you to remove the currently selected job from DI-Broadcast. You will be
presented with the Delete confirmation dialog. Once deletion is confirmed, the job will be removed
permanently. If the job is needed later, it has to be recreated.

Copy job...

Copy job allows you to copy all of the properties of the currently selected job. When this menu
item is selected, it launches the New Job dialog with all properties of the copied job already set.
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Execute job...

Execute job allows you to run the currently selected job. You will be presented with the Execute
confirmation dialog shown below:

Execute Job Now

Execute "Sales Marker" now?

es illa] ‘

Once “Yes” is selected, the job will run immediately.

Cancel job...

Cancel job allows you to stop any job that is currently running.

Review job history...

Select Review job history to open the dialog below, allowing you to review the success or failure
of attempted runs of the selected job. The Job History dialog only displays the last eight job run

attempts.
Job History E|
Job Mame: |Sales b arker
Lazt run
Start Time A|‘W’h_l,l Begun |'W'h_l,l Ended
W 21201161806 Executed manually by Vadmin” — Finished successilly
Job Name

The Job Name area shows the name of the job being reviewed.

Last “x” runs

The Last “x” runs line specifies the number of run attempts being shown in the Job History dialog.
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Start Time
Start Time displays the date and time when the job began. The date is displayed in yyyy/mm/dd

format and the time is displayed in hh:mm:ss format (24-hour clock).
Why Begun
The Why Begun column shows what triggered the job to run.

Why Ended

The Why Ended column shows that a job finished successfully or, if a failure occurred, why it
failed.

Details...

The Details button will be active if the job has failed for any reason. Click this icon to open the Job
Occurrence Details dialog, which gives a more detailed explanation for the job failure than that
provided in the Why Ended column.

Close

Close exits the Job History... dialog and returns to the main DI-Broadcast interface.

Save Job Report...

Save Job Report allows you to save a simple, tab-delimited text file with the contents of the job
table. Depending on your needs, the report can be loaded into Excel for formatting or parsed by a
Data Integrator script.
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Events Menu

The Events menu allows you to create, manage, and execute DI-Broadcast trigger events.

Iﬂﬂ Wigw  Help

Manage event list,,.

Manage event list...

The Manage event list menu item opens the Events dialog shown below:

Events &l

I zer ~|Mame |
admin Mightly Build

New | | | ok |

This dialog shows a list of all abstract triggers, called events, that have been defined in either
DI-Broadcast or DI-Scheduler. It also allows you to create a new event. An event is a flag that tells
DI-Broadcast or DI-Scheduler to start a job based on the occurrence of the specified event. It is
important to note that a job can only wait for one event. The event can be triggered manually while
in DI-Broadcast, from a batch file, or by posting an event in DI-Scheduler. For more information
on posting an event, please refer to the DI-Scheduler manual.

New

Click the New button to open the New Event dialog, allowing you to specify the name of the new
event. Click OK to accept the name, or Cancel to return to the Events dialog. Multiple events
created by the same user cannot have the same name.

Enter the name of the new event:
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Execute

The Execute button allows you to manually trigger the selected event.

Delete

The Delete button removes the selected event from the list.

OK
The OK button closes the events dialog.

View Menu

The View menu allows you to view jobs created in DI-Broadcast and DI-Scheduler.

m Help

v All jobs
Scheduler jobs

All jobs

When selected, the All jobs menu option displays all defined jobs in both DI-Broadcast and
DI-Scheduler. In the example below, Sales Build is a DI-Scheduler job and Sales Marker is a
DI-Broadcast job.

[raily admin

Maonthly  admin

Scheduler jobs

The Scheduler jobs menu option displays only those jobs created in DI-Scheduler. Notice below
that when “Scheduler jobs” is selected, the Owner column is not present.

M arme ~[Type [Last Riun [Mest Run
Sales Build Dhaily & 20240111 16:09.07 2012 /02401 12:00:00

If you are not a DiveLine administrative user, you will not be able to see
Scheduler jobs. Selecting the Scheduler jobs menu item will result in an
empty jobs list.
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Help Menu

The Help menu provides information about the DI-Broadcast software.

About DI-Broadcast, ..

About DI-Broadcast

The About DI-Broadcast dialog displays the version of DI-Broadcast in use, the DiveLine
version, server name, and port number, the type of user that is connecting (administrative or
non-administrative), and which DI-Broadcast and DI-Scheduler capabilities have been configured
on the DiveLine server.

-

About DI-Broadcast...

|

é Dimensional Inzight, 1.
DI-Broadcast 6.4 [46]

Copypright 1991-2015 Dimenzsional Insight, [nc.

DiveLine Information:

Server localhost
Diveline Wersion 6.4 [40]
Connection encrypted with SSL [AES20E-5HA]

When fully scrolled, the text in the About DI-Broadcast dialog appears as follows:

Diveline |nformation:

Server localhost
Diveline Werzsion B.4 [40]

Connection enciypted with 551 [AES52586-5HA]

Additional [nformation:

Authentication information:
Ilzer iz ah administratar
Scheduler Engine information:
Can broadecast email.
Cat run Builder.
Can run I nkegratar.
Can zend error reports.
Cat wait faor file az an action.

2-10

The DI-Broadcast Environment



Chapter 3 Do
Creating and Editing Jobs

DI-Broadcast can be used to automate the sending of Marker information via e-mail. A recurring
job can be scheduled so that as Model data is updated, e-mails can be immediately sent.

Creating a new job in DI-Broadcast is a simple process described in the paragraphs that follow. To
begin creating a new job, go to Jobs > New job..., or click New in the main DI-Broadcast interface
to open the New Job dialog. The Edit Job dialog mirrors the New Job dialog described below.

General Tab

The first area displayed in the New Job dialog is the General Tab shown and described below:

New Job 3

General l Schedulel MarkerSettingS] Ermail Settings] .ﬁ.dvanced]

Job Mame: |Sales M arker

Comment; |M|:ur1thI5I Eranch Sales

Last Run: MHaone

(1] 4 | Cancel
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General Tab

Job Name

Enter the name of the job being created on the Job Name line. Give the job a name that is related
to the job’s purpose—for example, “Sales Marker” or “Product Tracking”. Job names are limited
to 64 characters.

Comment

The Comment area can be used to enter additional information about the job. For example, if the
name of a job is “Sales Marker”, the Comments line might say “Monthly Branch Sales” to further
describe the job being created.

Last Run

The Last Run line lists when the job ran last. When creating a new job, this line will say “None”.
When editing a job, it will give the date and time of the last run in yyyy/mm/dd and hh:mm:ss
formats.

OK

When you have finished configuring or editing a job, click OK to save the changes or newly
created job and close the New Job dialog.

Cancel

Cancel closes the New Job dialog without saving the new or edited DI-Broadcast job.
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Schedule Tab

Schedule Tab

The second area of the New Job dialog is the Schedule Tab. The appearance of this tab varies,
depending on the Schedule Type chosen.

Type

The Type area of the Schedule tab is where you specify how frequently a job should be run.
Options are as follows:

Hourly

When the Hourly option is selected, you can specify the minute past the hour that the job should
run and a window of time in which the job should run. For example, if the job should run at fifteen
minutes past every hour for one week starting on June 4th, 2012, you would enter or select 15 in
the Every hour at box, Jun 4, 2012 in the From box, and Jun 10, 2012 in the Until box. This
option is useful when sending a report of which users are logged into the DiveLine server and
which Models are being used on an hourly basis.

New Job X

General  Schedule lf-‘-.ctians] p‘-‘-.d\-'anced]

Type: &+ Howly  © Daily " weekly " Monthly © Yearly
" Once O Ewent " Mewer " Other

Ewery hiour at 15 il mirutelz] pazt the hour.

r Indefinitel
From| Jun 4, 2012 2] g3)| neeiniey

* Unti Jun 10, 2012 -2

(1] 4 | Cancel
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Schedule Tab

Daily

The Daily option allows you to specify the hour of the day that the job should run, by entering or
selecting the desired hour from the Every day at box, when the job should begin running (From),
and how long it should run for (Indefinitely or Until). This option is useful when tracking the

daily progress of a specific product during a promotional period.

New Job

Genheral  Schedule lActiDns] r-‘«dvanced]

" Daily
" Ewvent

Type: © Hourly
" Once

" wheekly

" Mever " Other

Ewery day at

12:00:00 P 3:

* |ndefinitely
" Until

From| Jun 4,2012 -4

" Monthly © Yearly

B

o ]

Cancel

34
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Schedule Tab

Weekly

The Weekly schedule type allows you to select a specific day of the week to run the job on, a
specific time of day to run the job (at), when the job should begin running (From), and how long
it should run for (Indefinitely or Until). This option may be used for a running a weekly report that
summarizes business day data on the weekend.

New Job X

General  Schedule lf-‘-.ctians] p‘-‘-.d\-'anced]

Type: O Howtlp O Daily * Weekly " Monthly © Yearly
" Once O Ewent " Mewer " Other
Ewery week on the following day(=]: v Saturday [ Sunday

[~ Monday [ Tuesday | “Wednesday [ Thursday [ Friday

at | 12:00:00 P El:

f* |ndefinitel
From| Jun 4, 2012 -2 (| g
 Uni <]

(1] 4 | Cancel
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Schedule Tab

Monthly

A Monthly schedule allows you to select either a specific day of the month or a specific
positional day of the month (the first Sunday, for example), the time of day that a job should run
(at), when the job should begin running (From), and how long it should run for (Indefinitely or
Until). Monthly jobs are commonly used to send Sales Reports or Inventory Reports.

Mew Job
General  Schedule lf—'«ctions] Advanced]

Twpe: O Hourly
" Onee

" Daily
" Ewent

" wWeekly
™ Mever

" Other

@1 ilst day of the month.

Ewery month, an the

st =]

at | 12.00.00PM -2
From| Jun 4, 2012 -2 (|

= Until

{* |ndefinitely

J af the manth.

[ Jun 42012 2{E

o Monthly © Yearly

3

o]

Cancel
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Schedule Tab

Yearly

A Yearly schedule allows you to execute a job once per year on the specified day or days, starting
at the specified time and running indefinitely or until a given end date. A Yearly schedule might be
used to send annual or semi-annual Sales Reports showing Year-to-Date or Quarter-to-Date

" Monthly ™ Yearly

B

information.
New Job
General  Schedule lf-‘-.ctians] p‘-‘-.d\-'anced]
Type: © Howly  © Daily " Weekly
" Once O Ewent " Mewer " Other
Ewery pear on the following day(z]:
Jun1 E.:
Remaove
at | 12:00:00 P4 EI:
& |ndefinitel
From| Jun 1, 2012 =g Y
" Urtil EI
(1] 4 |

Cancel

Creating and Editing Jobs
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Schedule Tab

Once

Running a job using the Once schedule type allows you to specify the date and time for which to
run a non-recurring job. This option is useful for sending any reports that are not commonly
needed by multiple users.

New Job X
Genheral Schedule ]Actiuns] r-\dvanced]
Tope: O Howly € Daily " wieekly " Monthly T “Yearly
 Once  { Ewent " Mever " Other

On | Jund, 2012 S| at | 1200:00PM 4]

k. | Cancel
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Schedule Tab

Event

The Event option allows you to specify that a job should only run if the highlighted event occurs.
A specific event must be configured in the Events dialog prior to using this option. For information
on creating an event, refer to Events Menu on page 2-8 and to the DI-Scheduler manual.

General Schedule lMarkerSettings] E mail Settings] Advanced]

Tope: O Howly € Daily " wieekly " Monthly T “Yearly
(" Once ™ Ewvent " Mever " Other

On the following event: Fﬂlﬂlﬂ_

k. | Cancel
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Schedule Tab

Never

The Never schedule option allows you to create a job that can only be manually executed. This

option is most often used in a test environment to ensure that a job is sending the correct file in the
correct format or to perform some other test activity.

New Job 3
General Schedule lMarkerSettings] Email Settings | Advanced |
Type: © Howly O Daily " \weekly 7 Monthly © Yearlp
" Once 7 Event o Mever " Other

Thiz job will anly be executed manually.

Ok | Cancel
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Schedule Tab

Other

The Other option allows you to schedule the job at the specified minute interval. The options are
1, 5,10, 15, 20, or 30 minutes. This option is commonly used for incremental builds that need to

run every 15 minutes to refresh Markers.

]

New Job X
General Schedue | Actions | Advanced |
Type: © Howly 1 Daly " Weskly " Monthly  ‘Yealy
" Once ¢ Ewent " Mever * Othet
Everny 15 | minustes
*  Indefini
I-'n:ml Jun 4,202 Eﬁ S
" Unt E
oK Cancel

OK

When you have finished configuring or editing a job, click OK to save the changes or newly

created job and close the New Job dialog.

Cancel

Cancel closes the New Job dialog without saving the new or edited DI-Broadcast job.
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Marker Settings Tab

The next tab in the New Job dialog is the Marker Settings Tab shown below:

Mew Job ot

General | Schedule Marker Settings | Email Settings | Advanced |

Filename:

I Browse. .. |
DiveBook Area: | ;]
DiveBook Topic: | LI
Attachment File Type:

| =
DiveLine Usemame: ghueras ll

[ Do not send blank windows
[~ Embed Fonts

OK Cancel
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Marker Settings Tab

Filename

Click Browse in the Filename area of the Marker Settings tab to open the Select File dialog.

B | Select File X
Froject. ILacaI—Bugs El
Lok ir: | (] demo_drs j @ & .
£ Basic_cbase ProDiver_Marker.mrk £.| 0A-T abular-Report. mik
&) Product-Family-to-Product-Name Dive-cBase.mik - i QuickViews-Model-2.mrk
£ Product_Family_Model.mrk QuickYiews-Model.mrk
IH Product_Family_cBase.mik @ Sales_Region.mrk
£ Product_Name_TimeSeries.mik cBase-QuickViews. mrk
< >

File name: |Pmduct_Famiy_cBase. rirk. | Open I
Files of type: | DI-Broadcast Files .mrk..dbk) v Cancel |

You can select a Project or not, and browse and select the Marker or DiveBook to be used.

If you select a Marker or DiveBook from a Project, the Project and Filename display:

P
| New Job e

General | Schedule Marker Settings ] Email Settings | Advanced | ]

Project: Local-Bugs

| /demo_drs/Product_Family_cBase. mrk

DiveBook Area: |

DiveBook Topic: |
Attachment File Type:
| TAT [Tab-separated text]

Led Lo I'_l'_g

DiveLine Usemame: Ighueras

[ Donot send blank windows
[ Embed Fonts

OK Cancel
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If you select a Marker or DiveBook not located in a Project, the Filename line displays the path
and name of the chosen file.

o

General] Schedule Marker Settings | Email Settings | Advanced :

Filenarne: I
|£demu:u_n:|r3.u:||:nk Browsze. ..
DiveB ook Area: T abulars -
DiveBook Topic: Top 10 5alezpeople: Revenue hd
Attachiment File Tope:
|T}{T [T ab-zeparated text) i
Diveline Uzernane: |ghueras hd
| Do ot zend blank windows
| Embed Faonts

oK Cancel
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DiveBook Area and Topic

If the selected file is a DiveBook, you will be able to select the Area and Topic to use for your
DI-Broadcast job, as demonstrated in the two figures below:

Mew Joh

Genetal] Schedule Marker Settings l Email Settings] .ﬁ.dvanced]

Filenamne:
|.fHome.fMDdelxa‘demo-divebuok.dbk Browse. ..
DiveBook Area:
DiveBook Topic: Graphs
Attachment File Type:  [Peports
ElEMIEITE 1 Report Palettes
|PDF [Adobe Portable Doc| Quickiiews

Diveline Username: |al:|min

[ Do not zend blank windows
[ Embed Fonts

B

Cancel

o]

New Joh

General] Schedule Marker Settings l E mail Settings] Advanced]

X]

Filenarnne:
|.fH omeModelz/demo-divebook. dblk. Browse...
DiveBook Area: Tabulars ﬂ
DiveBook Topic:
: : Salesperson Tabular
Attachment File Type:  Fyorih/Product MuliT ab
|F'DF [Adobe Partable Doc| Region/Maonth Croz:T ab
tonthdS ales Begion MultiCrozsT ab
Diwveline Username: adrit j
[ Do not zend blank windows
[ Embed Fonts
(1] 4 | Cancel
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Attachment File Type

The Attachment File Type pulldown allows you to select the format to use to send the selected
file. Options include: TXT, CSV, XLS, XLSX, PDF, HTML, PNG, JPEG, TXT Attachment, CSV
Attachment, and HTML Attachment.

New Job X

General | Schedule Marker Setlings I Email Settings | Advanced |

Filenarne:

|.J'H ome/Models/sales. mrk Browse...

DiveBook Area: |

DiveBoaok Topic: |

Attachment File Tupe:
|F'DF [A4dobe Portable Document Format)

L4 LLt

TeT [T ab-separated best]

C5Y [Comma-Separated Yalues)

#LS [Microzaft Excel Spreadsheet]

FDF [&dobe Portable Document Format)

HTHL [Hypertest barkup Language)

FMG [Paortable Metwork Graphicz) b

Ok | Cancel

If the Marker or DiveBook topic selection is a Graph, only the PDF, PNG,
and JPEG format options will be available.

DivelLine Username

The DiveLine Username line specifies the username that should be used to open the Marker. This
may vary from the “Logged in as” username due to DiveLine permissions.

Do Not Send Blank Windows

The Do not send blank windows option, when checked, will prevent Markers resulting in an
empty window (for lack of data) from being sent to recipients.

3-16 Creating and Editing Jobs



DI-BROADCAST

Marker Settings Tab

Embed Fonts

The Embed Fonts option, only available with the PDF attachment type, allows you to embed font
information directly into the output PDF file. This will result in a PDF that is larger in size, and is
only recommended when a font used in a Marker may not be available on some recipients local
computers.

= = ™
o . ==

Generall Schedule Marker Settings |Emai| Settings | Advancedl

Filename:

IfSaIes.mrk Browse..

DiveBook Area: I

DiveBook Topic: I

Attachment File Type:
ICSV Attachment (Comma-Separated Yalues)

L L I‘_I‘_\_

Diveline Usarnarme: Ijon

[~ Donot send blank windows
[ Include Totals

Include Totals

The Include Totals option, available for TXT, CSV, XLS, and XLSX attachment types, allows you
to include the Totals row from the underlying Marker data.

OK

When you have finished configuring or editing a job, click OK to save the changes or newly
created job and close the New Job dialog.

Cancel

Cancel closes the New Job dialog without saving the new or edited DI-Broadcast job.
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Email Settings Tab

The fourth area of the New Job dialog is the Email Settings Tab shown below:

New Job 3

Genetal] Schedulel Marker Settings  Email Settings l.ﬁ.dvanced]

To |branchmanager@mycompany.cu:um

Cc |salesmanager@mycumpany.com

Beo: |

Subject: |Branch Sales Marker

Meszage:

Thiz email contains a PDF showing monthly zales for vour Sales Branch

(1] 4 Cancel

To

The To field allows you to specify a primary recipient or list of recipients that the e-mail should be
sent to. Multiple entries should be separated by commas.

Cc

The Cc (carbon copy) field allows you to specify additional recipients that should receive a copy
of the DI-Broadcast e-mail.

Bcc

The Bece (blind carbon copy) field allows you to specify additional recipients that should receive a
copy of the DI-Broadcast e-mail without primary recipients seeing that additional copies were
sent, or who they were sent to.
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Email Settings Tab

Click the ] icon next to any of the three address lines to open the Addresses dialog shown below,
allowing you to Add or Remove addresses from the Selected Addresses list.

Addresses E|

Diveline Uzer Addresses: Selected Addresses:

M arne | Address |
branchmanager@yourcompan...
zalesmanagerEyourcompany. ..

zalesmanagerEyaLurcompany. ..

Add
oK | Cancel

Subject

The Subject line contains a brief description of the e-mail being sent. For example, if a Sales
Report is sent to a group of Branch Managers, the subject line might say “Monthly Branch Sales”.

Message

The Message area contains any additional text that the DI-Broadcast user wishes to send to the
DI-Broadcast e-mail recipients.

OK

When you have finished configuring or editing a job, click OK to save the changes or newly
created job and close the New Job dialog.

Cancel

Cancel closes the New Job dialog without saving the new or edited DI-Broadcast job.
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Advanced Tab

The final area of the New Job dialog is the Advanced Tab shown below:

New Job X

Genetal] Schedulel MarkerSettingS] Email Settings  Advanced ]

[ “wait For file to exist:

[v Send eror reparts bo:

|admin@yaumampan}l.cun‘l

v Automatically abort the job after:

|1_ :‘ hours

(1] 4 | Cancel

Wait for file to exist

The Wait for file to exist check box tells DI-Broadcast that it should not execute the job unless the
file specified here exists. This is typically an empty trigger or event file indicating Models have
been updated.

Send error reports to

This option allows you to Send job error reports to the specified e-mail address(es). To specify
more than one address, separate each with a comma.

Automatically abort the job after

This check box allows you to tell DI-Broadcast to stop executing a job after “x”” number of hours.
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Advanced Tab

OK

When you have finished configuring or editing a job, click OK to save the changes or newly
created job and close the New Job dialog.

Cancel

Cancel closes the New Job dialog without saving the new or edited DI-Broadcast job.
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